									Chapter 4

Command Reference



Introduction



This chapter �XE "Command: reference"�provides a detailed description of each SNMPc command, along with examples of each menu and dialog box that support the product's functionality. The SNMPc commands are listed and described under nine menus, which are summarized in the following table.



Menu Group�Description��File�Open, save and print map and log files��Edit�Create, edit/delete nodes, clipboard operations��Map�Find nodes and nets; change map view��Log�Manipulate Log Window view��Manage�SNMP polling and management��RMON�Configure RMON probes and view RMON data��Config�Global configuration attributes��Window�Arrange sub windows��Help�Display help information��



Login Security



SNMPc includes multi-user/multi-level login.  When you start SNMPc from the Program Manager, you will be prompted for a user name and password.  The initial user and password is set to admin and an empty string.  You can create new users and change passwords using the Config / Edit Users command.



Each user can have one of three permission levels: Supervisor, Operator, or Observer.  The following table describes the capabilities of each level.



Level�Restrictions��Supervisor�Full access.��Operator�Open Map but no edit.  Device sets OK.

No SNMPc configuration.��Observer�No open/close map or map edit.  No device sets. No program exit.  No edit user.  No SNMPc configuration.��

�File Menu



The network map is maintained in a map file. The map file contains information about node names, position, and network connectivity. There may be more than one map file describing different logical networks. The File Menu contains �XE "Map: file operations"�options to create, open, save, and print the map file.



When errors are detected, or traps received by SNMPc, a message is written to the active log file. The File Menu �XE "File menu"�contains options to open the active or other log files, and to print windows.
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New Map



Use the New Map�XE "New map: command"� �XE "Delete: map: new map command"��XE "Empty map: new map command"��XE "Erasing current map: new map command"�command to release all information regarding the current map. If the map has been modified, you will be asked if the changes should be saved. All open windows will be destroyed except for the open log file windows, and a single top level map window. 



The frame title bar will be changed to (NOMAP) and the selected object in the status bar will be changed to (NO-OBJECT).



Open Map



Use the Open Map �XE "Open: map"�command to open a map file. A dialog box prompts for the filename.



When a map is opened, the current map is released. If the current map has been modified, you will be asked if the changes should be saved. As with the New Map command, the Open Map command will destroy all windows except for a single top level map window and any open log views. The Open Map command is always enabled.



The title bar for a map window contains the name of the windows parent node. When you first open a map, the parent name is the name of the map file.



�Save Map



Use the Save Map �XE "Save: map"�command to save the current map to the current map file name. If the map was newly created, you will be prompted for a file name.  The Save Map command is only enabled if the current map has been modified.



Save Map As



Use the Save Map As command to save the current map to a new file. A dialog box is used to select a new file name.



If the specified file exists, you will be asked if it should be overwritten. The Save Map As command is always enabled.



Open Log



The Open Log command creates a window to view an event log file.  The Open Log dialog box prompts you for a file name.



You can select any log file to view.  The active log file is named current.log.  The history log file is named history.log.  When the Open Log dialog box is initially displayed, the active log file name will be displayed in the Log Name edit box.



The opened log file is displayed in a log view window.  The title bar shows the log file name.  See the Log Menu for more information about the log view window. 



Save Log As



Use the Save Log As command to save the selected Log View window.  A dialog box prompts for the file name.  Only the log view is saved.



Print



Use the Print command to print the contents of the active window.  The Print dialog box is displayed to get print parameters.



�



The print dialog parameters have different meanings depending on what type of window is selected, as described below.

�Map Window



Use the Selection radio button to print the currently selected window.  Use the All radio button to print the selected window and any hierarchies contained within the selected window.  To print the entire map, select the top level map window and use the All radio button.



Graph/Chart/Table Windows



There are no options for these window types.  The entire window will be printed as displayed on the screen.



Log Window



Use the All radio button to print the entire log view.  Use the Selection radio button to print only Log text that has been selected.



If the log view has been scrolled horizontally, the leftmost part of the printout will be at the same location as the leftmost part of the display.  Use this feature to print selected vertical portions of  log file views that are too wide to print on a page.



Exit



The Exit �XE "Exit command"��XE "Terminating SNMPc"��XE "Closing SNMPc"�command closes all SNMPc windows and terminates the program. If the current map has been modified, you will be asked if it should be saved If the Config/Save Settings On Exit option is enabled, SNMPc saves the window configuration �XE "Window: layout"��XE "Saving setup"�so that next time you start SNMPc the window layout will be the same. 



Edit Menu



The Edit Menu �XE "Edit: menu"�contains commands to create, edit and delete map nodes, and commands that operate with the Windows Clipboard. The Edit Menu is shown below.
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�Discover Nodes



Use the Discover Nodes �XE "Discover: nodes command"��XE "Automatic node discovery"��XE "Dynamic: discovery of nodes"�command to automatically detect SNMP nodes and add the nodes to the network map.  The first time you use this command the AutoDiscovery Setup dialog box will be displayed.



�	



Starting IP Addresses is a list of SNMP devices to start discovery from.  Generally you would use the address of your default router, however any active SNMP device can be used.  Enter an IP address in the edit box and press the Add button to add the address.  Select an address from the list box and press the Delete button to delete the address.  You must enter one or more starting addresses to discover IP nodes.



If you have IPX installed, select the Discover IPX Nodes check box to discover IPX devices.   Enter the maximum number of IPX bridges to cross during the discovery in the Max IPX Hops edit box.



Check the Limit To Starting Networks check box to only discover devices that are in the same subnetwork as the starting addresses.  If this is not checked, SNMPc will try to discover all devices on all networks.



Communities is a list of SNMP community names used during discovery.  Normally only the public community name is needed.  However, if any devices in your network do not respond to the public community name you must add the appropriate additional names.



Check the Allow broadcast check box to allow broadcast SNMP queries as part of the discovery process.



Enter a number in the Restart edit box to restart the discovery process at fixed intervals.  Normally the discovery process is started manually and terminates when no more devices are found.  Restarting discovery automatically ensures that new devices and devices that may have been turned off will be found.

�After pressing the OK button the main AutoDiscovery dialog box will be displayed.



�



The discovered nodes list box shows the network address, node type, and description of discovered devices.  This information is saved in a log file and is available during future invocations of this command.



Number of Nodes Discovered shows the total number of nodes that have been found.  Number of Nodes Displayed shows the number of entries currently displayed in the list box.  The displayed entries can be selectively displayed using the Filter button, which is described below.



The current discovery status is shown in the status box.



Use the Setup button to configure the discovery process, as described at the beginning of this section.



Use the Start button to manually start discovery.  If the discovery process is currently running, this button will be marked Stop and you use it to terminate the discovery process.  If you have setup a restart timer then there should never be any need to use the Start/Stop button.



Use the Clear Log button to delete the list of discovered nodes.



Use the Layout button to add all displayed devices to the SNMPc map.  Discover will add one hierarchy for each IP subnet, with all routers at the top map level and all end-nodes inside a subnet hierarchy.  Only the displayed devices will be added.



Use the OK button to minimize the discovery dialog box.  The dialog box is not normally terminated once started, however you can destroy the dialog box by using the Terminate command in the dialog box system menu.

�Use the Filter button to change the displayed devices.  This does not change the contents of the discovered nodes log file, only what is displayed.  Filtering allows you to selectively add portions of what has been discovered to the SNMPc map.  The Discovery Filter dialog box is displayed.



�



Use the Show nodes on map check box to display any nodes that are already layed out.  Normally these nodes are not displayed.



The Include list box shows a set of filters to match entries that will be displayed in the Discovered Nodes list box.  The Exclude list box shows a set of filters to match entries that will not be displayed in the Discovered Nodes list box.  The above example will display all devices in network 198.92.129.0 except 198.92.129.16 and 198.92.129.32.



Use the Include button to add a filter to the Include list box, or to modify the selected entry.  The following dialog box is displayed.
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Optionally enter a pattern for the IP address.  Use asterisk characters to match zero or more characters.  This example matches any device in the 198.92.129.0 network.  Optionally enter a pattern in the Description box that matches one or more descriptions in the Discovered Nodes dialog box.  Optionally select one of the device types from the Type pull down list box to match only specific device types.



Use the Exclude button to add a filter to the Exclude list box, or to modify the selected entry.



Use the Delete button to delete the selected entry.

�Edit Object



Use the Edit Object �XE "Add: node: command"��XE "Edit: node command: reference"�command to modify information about the selected node or network, or to add a new node.   If a network is selected, the Edit Network dialog box will be displayed.



�



You can change the description for the network and select Change to save it.



If a node is selected, the Edit Node dialog box displays the information for the selected node. If nothing is selected, the Edit Node dialog box displays the default node information.



�



Enter the appropriate information and press the Add �XE "Create: node"��XE "Map: adding nodes"�button to create a new node, or press the Change �XE "Change node"�button to change the selected node. If you change the node name, SNMPc will ask if you are sure (in case you accidentally pressed Change when you meant Add). Each information field is described below.

�Node Name



Each SNMPc node has a unique string as the Node Name. For Agent or Ping nodes, the Node Name can not contain spaces. 



Net Address/Goto Hierarchy



For an IP SNMP Agent or Ping node, Net Address �XE "Host name: for node name"�is the Internet host name�XE "Node name: edit node command"� for the node.  It must be a valid name with an entry in the  hosts database, or an Internet address�XE "Internet address: node host name"� in dot notation�XE "Dot notation: node host name"�.  An example IP address is: 198.92.129.19.



For an IPX SNMP Agent or Ping node, Net Address is an IPX address, of the form NET-HOST.  NET is the four byte network portion in hexadecimal, and HOST is the six byte host portion in hexadecimal.  An example IPX address is:

	0AAA1-001122334455



For a Goto node, this field is set to the name of the Hierarchy node to go to when you double click on the node,  or left blank to go to the top map level.  See the description of node type below.



Description



The Description �XE "Node attributes: description"�is a short text string describing the node. This string is saved in the map file, but not in the node, so it is essentially a comment.



Type



A Hierarchy node is a submap that contains other nodes.  When you double click on a Hierarchy node, a new map window is created and displayed.  This window contains nodes that exist within the Hierarchy node.  You can create new nodes within this window, or you can move nodes from other windows into the new one by dragging the node node icon across the window boundary.



A Goto node is an indirect link to a Hierarchy.  Each goto node has its Net Address set to the name of a hierarchy, or blank for the top level map.  You can enter the Hierarchy named in a Goto node by double clicking on the node.  You can place Goto nodes anywhere in the map and use them as shortcuts around the map.



An Agent node represents a manageable network device that has an IP or IPX SNMP agent in it.  You can use any of the Manage menu commands on Agent nodes.



A Ping node represents a device that contains an IP or IPX entity, but not an SNMP agent.  The device is polled using ICMP echo or IPX diagnostics.



Icon



Icon defines�XE "Workstat.ico icon"��XE "Map: icons"� �XE "Node attributes: node icon"�the icon that will be displayed in the map window for this node.



If you �XE "Bridge.ico icon: selecting node icon"�do not know what kind of icon to use, select auto.ico�XE "Monitor nodes: automatic icon selection: specify for node"��XE "Icon: automatic selection: specify for node"��XE "Automatic icon selection: select as node icon"��XE "Object identifier: automatic icon selection: described"�. SNMPc will then automatically select an icon based on the Node Identify variable value. SNMPc will select a question mark icon for nodes that do not respond at all. 

�You can create new icons and add them to the list. Refer to Chapter 7, Customizing SNMPc, for instructions on how to do this.



Exec



Exec is an SNMPc Applications Programming Interface (API)�XE "Enterprise Specific MIB: node API exec program"��XE "Applications Programming Interface (API): execute on double click"� program that is executed �XE "Run API program: on mouse double click"��XE "Node attributes: API exec program"�when you double �XE "Execute API program: on double click"�click on the node.  An API program accesses the functionality of SNMPc through a WinSNMP or Windows  DDE interface. API programs usually provide a special user interface for Enterprise Specific MIB definitions.



The default API program is auto.exe.  This is not a real program, but tells SNMPc to select a  program based on the device Node Identify variable value.  Most devices are set up to use hubview.exe.  The hubview program shows an image of the nodes'  port configuration, and includes a menu structure that is specific to the node type.



For more information on API programs, see the Manage/Run API program command, Chapter 6, Applications, and Chapter 7, Customizing SNMPc. 



Community



Use the Comm �XE "Community name"��XE "Poll: community name"�button to set the community name that SNMPc will use for SNMP operations. The following dialog box will be displayed.



�





Get is the string used as the community name in SNMP Get and GetNext requests.



Set �XE "Set: community name"�is the string used as the community name in SNMP Set operations.



Trap is the string used as the matching community name for received traps.  You can create multiple nodes with the same IP address but different Trap strings, for use with Proxy agents.



Default sets the default  values of public for Get and Trap, and netman for Set.

�Poll Interval



Use the Poll Int �XE "Poll: interval"��XE "Monitor nodes: poll interval"�button to set the amount of time between SNMPc polls. The following dialog box will be displayed.



�



SNMPc normally polls every node in the network at specified intervals. The Poll Interval specifies how many seconds between each poll. The default is ten seconds. Care should be taken when selecting the poll interval. Too short a poll interval could flood the network with SNMP requests. Too long a poll interval may cause slow response to network errors�XE "Default: poll interval"�. 



See the Manage/SNMP Poll command for a complete description of the normal SNMPc poll function.



Poll Vars



Use the Poll Vars button to set the variables that SNMPc requests from the node during each poll interval. The following dialog box is displayed:



�



Node Identify is a variable that determines the device type. This is the System Object Identifier, sysObjectID, by default. The result of this variable is used for automatic icon selection and to select a HubView device definition file.



Node Status is a variable that determines the general node status.   When the node is polled the status OK Value is compared to the returned value.  If it is not the a  "Node Status DOWN" message is written to the log file. If the value is correct on a subsequent poll a "Node Status UP" message is written to the log file. 



Use the Get buttons to update the OK Value pull down integer alias list for the selected variable name.



Use the Default button to set the default poll variables. 

�Ports



Use the Ports button to set the network name and SNMP polling variables for up to twenty four device ports. The following dialog box is displayed.



�



Network Attachments is a list of all networks the node is attached to.



Use the Add button to add a new network attachment which is described in the set of edit boxes.  Use the Delete button to delete the selected entry from the Network Attachments list box.



Port Number is used for log file entries related to the port.  It can be any number but probably will be directly related to the physical port number.



MAC Address is the ethernet physical address for the port.



Attached to Net is the network name the port is connected to.  The Network Name �XE "Network: segment names"�is of local significance to SNMPc, and does not reflect any possible Internet network name. The Network Name is used to draw the network map with the appropriate network segments and node attachments�XE "Node attributes: network attachments"�. All ports that are connected to a particular network segment must have the same Network Name.



Description is any text describing the connection , such as type, speed, etc.



Poll MIB variable is a complete SNMP MIB variable with instance that will be used to poll the port status.  This would normally ne ifOperStatus.num for port number num.  However, it can be any standard or private variable.



Poll OK is the value that is expected to be returned for the MIB variable when the port is functioning normally.  The port will be drawn blue if the value is correct, and red otherwise.

�See Chapter 3, Users Guide, and the Manage/SNMP Poll command for more information about how networks are depicted in a map window.



Node History



Use the Node History command to select SNMP tables to be polled and saved in a file.   The data is saved by the separate TrendWatch program.  You can use TrendWatch to export the saved data, and to view monitored data in real-time meters.  TrendWatch is described in Chapter 6, Applications.  The Node History dialog box shows the selected tables for the current node.



�



Tables To Save is a list of selected tables. Click on an existing entry to select it.  



Table Name is the name of the SNMP table to be saved. This must be a valid table name with a valid SNMP instance.  If you don't know the instance number or format, use the Display MIB Table command from the Manage menu to display a table, and then use the Hist button to select a table entry.



Use the Delete button to remove the selected entry. 



Use the View button to run the TrendView program for the selected table.  TrendView displays the data as a graph, pie, or bar chart.  TrendView is described in Chapter 6, Applications.

�

Use the Edit button to set the polling interval, to select which table elements should be saved, and to set threshold values for variables. When a threshold is exceeded, a Trigger event is generated. The following dialog box is displayed.



�



The table variable names are displayed in the left column.  Use the edit boxes in the right column to specify threshold values. Use the pull down lists to select integer aliases. 



Use the Save check box to specify that a variable should be saved. You do not need to save variables that will only be used to check thresholds.



For tables that have more than ten variables, use the "<<" and ">>" buttons to move between sets of variables. 



The node will be polled for the selected table every Poll time periods, between the From and To times specified.  All times are in hour:minutes:seconds format. Use the Weekday check boxes to poll only on certain days.



Use the Reset button to clear all edit boxes and set all Save check boxes for all Counter variables in the table.

�Node Defaults



Use the Node Defaults command to set default values used when adding a new node with the Edit Object command.  The following dialog box is displayed.
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Icon is the default icon to use.  This is normally set to "auto.ico", which lets SNMPc select an icon automatically, based on the Node Identify variable value.



Exec is the default API program to use.  This is normally set to "auto.exe" which lets SNMPc select an executable automatically.



Use the Comm, Poll Int, and Poll Vars buttons to set default values for the Community Name, Poll Interval, and Poll Variables, respectively.  These buttons display the same dialog boxes as with the Edit Object command.



Use the Default button to set all values to the installation state.



Delete Object



If a map window is selected, use the Delete Object �XE "Delete: node command"�command to remove the selected nodes and networks from the map. You will be asked if you are sure that the objects should be deleted.



The Delete Object command can also delete Hierarchy trees. If a hierarchy node has children you will be informed of the number of children and again asked to verify the operation.



If a log window is selected, use the Delete Object command to selete the selected log entries.



If a MIB table window is selected, use the Delete Object command to delete selected variable name columns.

�Copy



Use the Copy Command to copy selected �XE "Copy: copying selected text"��XE "Clipboard: copy command"��XE "Active: window: selecting text"�text or attributes of the selected node into the Clipboard.

Cut



Use the Cut command to delete the selected text and copy it to the clipboard. You will be asked to verify the operation. The Cut command can not be reversed, and it affects the file, not just the memory image.



This command is only enabled if some text has been selected in the active window.



Paste

Use the Paste command to set Copied node attributes to one or more selected nodes.  The Paste Node Attributes dialog box is displayed:



�



Set one or more of the Node Attribute check boxes to select which attributes will be pasted onto the selected nodes.  Select the In View radio button to paste onto selected node in the current View.  Select the In Map radio button to paste onto all selected nodes in the map.  Use the Map/Select Nodes command to select multiple nodes in the entire map.

�Map Menu



The Map Menu �XE "Map: menu"�contains options to manipulate the view of the map. The Map Menu is shown below.
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Map Grid

Use the Map Grid command to set the grid to which nodes and network junctions snap when they are moved.  The following dialog box is displayed.



�



Enter the horizontal and vertical grid spacing in the X and Y edit boxes, respectively.  The grid spacing is in pixel units.  Select the Show Grid check box to display grid points on the map.



Set Map Image



Use the Set Map Image command to associate a Windows bitmap with the currently selected map window.



The Set Map Image dialog box is displayed.



�

�Use the Delete button to remove the bitmap from the map window. Use the Open button to select a Windows bitmap file. 



 A dialog box prompts for the file name. You can select any Windows bitmap file, which have a  ".bmp" extension. The default directory for SNMPc bitmaps is c:\snmpc\bitmaps.

Lock Map



Use the Lock Map command to enable or disable the ability to move or edit nodes. Selecting this option toggles the current locked state. A tick mark in the menu option, and a highlighted Lock keyword in the status bar indicates the locked mode is enabled.



Navigate



Use the Navigate command to display the network map hierarchy as a tree. The Navigation Tree is a separate window that can be scrolled, minimized, and maximized. The following is a sample Navigation Tree.
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Each node in the Navigation tree corresponds to a hierarchy node in the network map. The same icon is used to easily distinguish different hierarchies. The worst status of any nodes with each hierarchy is depicted by a colored icon background. A red background indicates one or more non-responding nodes. A yellow background indicates one or more nodes with a bad Node Status variable.



Double click on any icon in the Navigation Tree window to open a map window for the associated hierarchy node.

�Find Object



Use the Find Object �XE "Find: node by name"��XE "Map: finding objects"��XE "Node name: find node"��XE "Node selection: with find command"��XE "Select: node by name"�command to select a node or network by name. A dialog box displays a scrollable window containing the names of objects.
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Select the Nodes radio button to show only Agent node names.  Select the Hierarchies radio button to show only Hierarchy node names.  Select the Networks radio button to show only network names.



Push the Find button to find the selected object.  A map view window containing the selected object will be displayed.



Select Nodes



Use the Select Nodes command to select one or more nodes in the current view or in the entire map.  The nodes selected can then be used by the Edit / Paste command. The following dialog box is displayed.



�



Set the Agent Type check box to select Agent Nodes by the value of the Node Identify variable.  You must also select one of the Agent node types from the pull down list box.



Set the Hierarchies check box to select all Hierarchy nodes.

�Set the In Current View check box to select nodes from the currently selected map view.   Set the In Entire Map check box to select nodes from the entire map.  To deselect all nodes, do not set either of these check boxes.



Center Map



Use the Center Map �XE "Center map"��XE "Map: changing view"�command to redraw the map segment so that the center of the segment is in the center of the window.



Clear Border



Use one of the Clear Border menu options to remove the colored event border from one or more nodes. Three submenus are available to clear the border from the selected node, the selected hierarchy window, or all nodes.  Node borders are only set by third party application programs.



Zoom



Use one of the Zoom menu options to enlarge or reduce the map window contents. The ZoomIn �XE "Zooming map"�command enlarges the map window contents. The ZoomOut command reduces the map window contents size. The ZoomNormal command sets the map window contents to the normal size. 



Arrange



Use the Arrange commands to automatically arrange the selected network or nodes.  This command has several sub-menus, defined below.



Snake Net



Use the Snake Net command to arrange the selected network as a snaked bus. All nodes attached to the network will also be relocated.  The mouse cursor will change to a bar, indicating a network. Click on the map window at the place where you want the network to be drawn.

�The following is a sample Snake network.
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Ring Net



Use the Ring Net command to arrange the selected network as a ring. All nodes attached to the network will also be relocated.  The mouse cursor will change to a bar, indicating a network. Click on the map window at the place where you want the network to be drawn.  The following is a sample Ring network.
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Snap To Grid



Use the Snap To Grid command to move all selected nodes to the nearest map grid point.

�Log Menu



The Log Menu �XE "Log file: menu"�contains options to open log views, modify what is displayed in a log file window, and to search for a log file entry. The log menu is displayed below.
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The following is an example of a log view window.
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SNMPc maintains two event log files.  The Current log file is cleared each time you start SNMPc.  The current log file determines what color a node is displayed on the map.  Each node will be displayed the color of the highest priority entry in the current log file.



Each entry in the current log file is also written to the History log file, which is not cleared when SNMPc starts.

Refer to the Event Filters command for a description of how to control what generates an event in the log file.



You can display the node associated with any log entry by double clicking the left mouse button on a log entry.

�View Node



Use the View Node command to display the current log file entries for the selected node.



View Node History



Use the View Node History command to display the history log file entries for the selected node.



View Current



Use the View Current command to display the current log file.



View History



Use the View History command to display the history log file.



View Filter



Use the View Filter �XE "View filter command"��XE "Event: log view filter"��XE "Filters: log view"��XE "Log file: view/search filter"�command to filter out part of the log file contents from the log window, thereby displaying a subset of the log file. The View Filter dialog box prompts you for the filter parameters. Only those log file entries that match the View Filter will be displayed in the log window.

��



Each log entry is assigned a numeric priority from 1 to 6, where 1 is the highest priority, and 6 is the lowest.  Each priority is assigned a color, as follows:

	

	1	Red

	2	Yellow	

	3	Magenta

	4	Blue

	5	Green

	6	Clear

�Select an entry from the Priority list box to match all entries with the same or higher priority.



Pattern Matching Strings



Log file �XE "Pattern matching strings: log view filter"�entries are made up of Node Name�XE "Node name: log view filter"�, Event Type, and Message fields. To match an entry, you must match all of these fields.



You can place pattern matching strings in the Node Name and Message edit boxes. These strings are used to match against the corresponding field of an entry. A pattern matching string is made up of normal characters, which match the same characters in the log entry, and the "wild card" asterisk symbol, ( * )�XE "* symbol: log view filter"��XE "Asterisk (*) character: log view filter"��XE "Wild card (*) symbol: log view filter"�, which matches zero or more of any character.



The following table shows some examples.



Pattern�Description��tvi386*�In the Node edit box, matches any nodes starting with "tvi386", such as tvi386a, tvi386b, etc.��crPortLinkState.1.*�In the Message edit box, matches Plexcom Port Link State change traps for any port of module 1.��

You can use more than one wildcard star in the pattern string. Also, if the edit box is left blank, it matches everything. To avoid problems with different numbers of spaces, always use a single asterisk symbol in place of spaces.  See the Log File Messages section of Appendix A for a description of the event message strings.



Event Types



The Event Type check boxes must be set to match one or more event types. To match any event type, check all of the boxes. The following table describes each event type.



Event Type�Description��Info�XE "Info event type: log view filter"��An Information event, such as "log file opened". Positive information about nodes, such as "node responding to SNMP".��Err�XE "Err log file type: log view filter"��An SNMPc error or negative information about nodes, such as "Node not responding".��Mib�A MIB compiler error.��Trig�A threshold exceeded event for a polled variable set up with the Edit/Node History command.��Trap�XE "Trap: log view filter"��An SNMP trap received from the node. The message will contain the node sysObjectID value, the Trap MIB variable names and values.���Trap Message Filters



Use the Traps button to create a pattern matching string for traps. The Trap Filter dialog box displays the available trap types and trap variables.



�



Use the Enterprise pull down list to select a manufacturer. 



Use the Trap Type list box to select an available trap type for the selected enterprise.



Once a trap type is selected, the variable names for that trap are listed in the left column.  Use the Values edit boxes to select matching values for each variable. Use the pull down list boxes to select aliased integer names.



Search Filter 



Use the Search Filter �XE "Filters: log search"��XE "Find: log file entry"��XE "Search log file"�command to find a log file entry within the log view. 



The Search Filter dialog box will be displayed. It is exactly the same as the View Filter dialog box, and functions in the same way. After you have entered the matching information, SNMPc will locate the first entry in the log view that matches your filter, and display it at the top of the log window.



Search Next



Use the Search Next command to repeat a search of the log view, using the same matching criteria that was last entered with the Search Filter command. If the Search Filter has not been set, Search Next will just go down the view one line.



Clear Log



Use the Clear Log command to clear the contents of the selected log file.  If the selected log file is not active it will be deleted and the log view window will be closed.
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